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Excel 2007: A First Look

The Excel 2007 Interface

The Ribbon

Excel 2007 has a new interface called the Ribbon.
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The Ribbon is made up of tabs which contain commands and familiar Excel icons.

The tabs are arranged across the top of the screen. The tabs are Home, Insert, Page Layout, Formulas,
Data, Review, View, and Add-Ins.

These tabs are not customizable.

The Office Button

J/’
In the top left corner you will find the Office Button: e
This is where you will find New, Open, Save, Save As, Print, Close and Exit.

There is also an Excel Options button which is used to customize Excel’s behavior.

Double-clicking on the Office Button exits out of Excel 2007, prompting you to save if you have not
saved changes.

The Quick Access toolbar: Save, Undo, Re-do
Beside the Office Button is the Quick Access toolbar, which has icons for Saving, Undoing and Redoing.

d9-0 -

This is the only customizable part of the interface. You can customize this toolbar by clicking on the
down arrow and clicking the elements you wish to add to the toolbar, or un-clicking them to remove
them.



Help

Help is located on the far right side of the screen, under the question mark icon.

You may browse for help, or type in a subject you want help on in the search field

You can also click on Table of Contents and look at the available topics.

To Do:

1. Click on the Help button @

2. Click on Table of Contents button
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Browse Excel Help

What's new Getting help

Installing Activating Excel

Customizing Accessibility

File conversion and compatibility ‘Workbook management
Worksheet and Excel table basics Formula and name basics

Function reference Filtering, sorting, and conditionally

formatting data

Summarizing, consolidating, and Validating data
outlining data

Importing data PivotTable reports and PivotChart
reports

What-if analysis ‘Working with XML

Charts Security and privacy

Macros Excel and the Web

Automation and programmability Working in a different language
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3. Click on Training to explore additional Excel 2007 training.



The Name Box, the Insert Function Button, and the Formula Bar
Located under the Ribbon is the Name Box, the Insert Function button, and the Formula Bar
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The Name Box identifies which cell you are currently in on. The Function Button allows you to insert a
function, and the Formula Bar allows you to type in a formula.

Excel Terminology
Here are some terms you need to know:

Worksheet: Worksheets are made up of columns and rows. Excel 2007 allows you to have over 1
million rows and 16000 columns in a worksheet.

Workbook: A Workbook is made up of one or more Worksheets. Each Workbook starts with 3
Worksheets but Excel allows each Workbook to have up to 255 Worksheets. Tabs at the bottom of the
Workbook show the different Worksheets in this Workbook. You can add a new Worksheet by clicking
on the New Worksheet tab.

v
M4 4 » M| Sheetl ~ Sheet2 - Sheet3 ~¥]

You can rename, move, copy, hide, or delete a Worksheet by right clicking on the Worksheet tab.

Cell: Worksheets are made up of cells. The cells are referenced by Column,Row. Columns are listed
across the top and are named A, B, C, etc. Rows are listed down the side and are numbered 1, 2, 3, etc.
The first cell in the worksheet is named Al. The cell under Al is A2. The cell beside Al is B1.

Navigating the Worksheets in the Workbook

There are two ways to move between Worksheets.

1. Press Ctrl - Page Down on the keyboard to go to the next Worksheet.
Pres Ctrl - Page Up on the keyboard to go to the previous Worksheet
2. Click on the Worksheet tab to bring a particular Worksheet into view
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Navigating the Content of the Worksheet
You can move around within a Worksheet by using the keyboard or the mouse.

Using your keyboard:

To move... Do this...

Right one cell Tab or right arrow key
Left one cell Left arrow key

Up one cell Up arrow key

Down one cell
Up one screen

Down one screen

Enter or down arrow key
Page Up key
Page Down key

Leftmost cell in a row Home key
Upper left corner of a Worksheet Ctrl - Home
Using your mouse:

To move... Do this...

Up or down one row
Up or down one screen

Up or down any amount
To a specific cell

Click the up or down arrow on the vertical scroll
bar.

Click the vertical scroll bar between the box and
the up or down arrow.

Drag the scroll bar up or down.

Single click in the cell

Note: When you move around your Worksheet with the mouse, this does not move the cursor. After

you have used the mouse to move to a section of the Worksheet, click the mouse on the appropriate

cell.

Selecting Cells Inside the Worksheet

Single click on cell to select it.

Click and drag to select more than one cell.

Click on column header to select entire column.

Click on row header to select entire row.

Single click in one cell, hold down Shift key, click in another cell to select all cells in between.
Single click on a cell, hold down Ctrl key to select multiple cells that are not contiguous.



* Select entire Worksheet by clicking the Select Worksheet button in the top left.
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¢ Single click inside any cell to de-select it.

Entering Content

There are several types of data that you can enter into the cells of the Excel Worksheet:

e Text

*  Numbers
* Dates

* Times

*  Formulas
*  Functions

To enter data into a cell:

1. Click in the appropriate cell.
2. Type the data. The data will appear in the cell and the formula bar as you type.
3. Press Enter.

Entering Text
¢ Text can be any combination of letters, numbers, and spaces.
* If you want to enter a number as text (such as a phone number), simply precede the number
with a single quotation mark.
¢ Textis left-aligned in a cell by default

Entering Numbers
e Valid numeric data include the numbers 0-9 and many special characters (such as $ and %)
* To enter a negative number, precede it with a minus sign, such as -256 or surround it with
parentheses, such as (256).
* Numbers are right-aligned in a cell by default.

Entering Dates and Times
* You can enter dates using hyphens - or slashes /.
* You can enter times by using a colon :
* Excel will use the AutoFormat feature to automatically format dates and times that you enter.
You can reformat the date and time by going to the Home tab, the Numbers category, and
choosing the format you want from the drop down menu.



MNumber | alignment Font Border Fill Protection

Category:

General Sample

Number

Currency

Accountini Type:

Time *3/14/2001 ~
*

Percentage 3>hllzdnesday, March 14, 2001

Fraction

ScientlFy 3114/01

cientific 03714701

Text 1 4; M /

Special e 2

Custom 14-Mar-01
Locale (location):
English {U.5.) v

Date Formats display date and time serial numbers as date values. Date formats that
begin with an asterisk (*) respond to changes in regional date and time settings that are
specified For the operating system. Formats without an asterisk are not affected by
operating system settings.

TO DO Enter some content into your Worksheet

Click in A1 and type Budget for January and press Enter. (Don’t worry that the text doesn’t seem to fit
inside the column right now)

In B2 type Amount Allocated.

In C2 type Amount Used.

In D2 type Amount Left in Fund.

In A3 type Mortgage Payment and press Tab.
In B3 type 900 and press Tab.

In C3 type 900 and press Enter.

In A4 type Car Payment and press Tab.
In B4 type 350 and press Tab.

In C4 type 350 and press Enter.

In A5 type Entertainment and press Tab.
In B5 type 200 and press Tab.

In C5 type 300 and press Enter.

In A6 type Groceries and press Tab.

In B6 type 350 and press Tab.



In C6 type 200 and press Enter.

In A7 type Gas and press Tab.

In B7 type 200 and press Tab.

In C7 type 175 and press Enter.

In A8 type Utilities and press Tab.
In B8 type 200 and press Tab.

In C8 type 225 and press Enter.

In A9 type Total.

Your sample data should look like this right now:

A B C D E
1 Budget forJanuary
2 Amount A Amount UAmount Left in Fund
3 'Mortgage 900 500
4 Car Payme 350 350
5 Entertainr 200 300
6 Groceries 350 200
7 Gas 200 175
8 |Utilities 200 225
S5 Total
Notes:

* If you are entering content and want to cancel, just press the Esc key.

¢ If a cell contains content you want to change, just click on the cell and start typing in new
content.

* If you've entered content and there is a typo, or you want to make a slight change. Click on the
cell and then edit the content in the Formula bar, or double-click on the cell and edit the content
directly inside the cell.

* To duplicate cell content to the cell below it: Click in the cell below, hold down ctrl-key and then
the single quote beside Enter key.

* Tofill a range of cells with the same content, simply select the group of cells by clicking and
dragging te mouse. Then type in the content, hold down ctrl-shift and press Enter. The content
fills all the cells selected with the same content.

* Toremove content, select cell and use Del key.



* Toremove content from a range of cells, click and drag to select cells, then press the Del key to
delete.

TO DO. Edit the content in Al.

1. Click on cell A1 which contains the words Budget for January.
2. Go to the Formula Bar and modify it to be January 2007 Budget.

Resizing Columns

Notice that the columns are not wide enough to display the information that you typed in it. If you click
on a cell within a column, such as A5, you will see the contents on the Formula bar ok, but it is not
displayed in the Worksheet because of the column width. There are a few ways you can resize a column
to make it wider:

1. AutoFit the column to be wide enough for the contents by clicking on the column header and
then double-clicking the boundary on the right.
Use your mouse to manually drag the right border of the column header to the size you want.
Select the column header, then go to Home tab, Cells category, Format, and change the Column
width. You can set a value for it, or you can choose AutoFit Column Width from here also.

TO DO. Change the width of the columns.

Click on the column header for Column A.
Choose a method for adjusting the width (such as double-clicking on the boundary between A
and B or simply dragging the boundary until you can see all of the information in the cells).

3. Do the same for columns B, C, and D.

Formatting Text

New Feature: Mini Toolbar

One of the new features of Office 2007 is the Mini Toolbar, with formatting options. If you make a
selection and pause, you will get the ghost of the Mini Toolbar, if you move your mouse over it, it
solidifies.

The Mini Toolbar also shows up if you select text and right click.

TO DO Use the Mini Toolbar to make the word Total appear bold.

Double-click on cell A9.

Highlight the word Total and watch the Mini toolbar appear.
Hover over the toolbar and watch it solidify.

Choose Bold from the Mini Toolbar.
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5. The Mini toolbar disappears as you click or move away.

New Feature: Live Preview
Another new feature of Office 2007 is the live preview of text changes.

TO DO Change the font and size of text.

1. Select the words January 2007 Budget in Al.
2. Go to the Home tab, Font category, and go to the Font drop down menu.
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3. Asyou move through the fonts, your selection changes to give you a preview of what the text
will look like in that font.
4. Select a font and make it a bigger size.

Formatting Data in the Cells
Excel offers many options for formatting data in the cells. Cell formatting options are found on the
Home tab, the Cells category, then Format.

Part of the data in this Worksheet is numerical data that is currency, or money. Those amounts can be
formatted in several different ways.

TO DO. Format the numbers in the Worksheet to have dollar signs and decimal places.

1. Select the cells that contain the money data (B3 through E9)
A B C D

1 January 2007 Budget

2 Amount Allocated Amount Used Amount Left in Fund
3 Mortgage S00 500

4 CarPayme 350 350

5 Entertainr 200 300

6 Groceries 350 200

7 Gas 200 175

8 Utilities 200 225

9 Total



2. Go to Home tab, Cells category, Click the drop down menu under Numbers.
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3. Click on Currency and choose a style.

Number | Alignment Font Border Fill
Cateqgory:
General Sample
Mumber
900,00
:
Accounting ; 0 -
Date Decimal places: |2 =
Time Symbol: | §
Percentage
Fraction Neqgative numbers:
Scientific -$1.234.10
Text_ $1,234.10
Special ($1,234.10)
Custom ($1,234.10)

Inserting and Deleting Rows and Columns

Sometimes after you type data in your Worksheet you want to insert a row or a column. You can insert
a new row or column in your worksheet a couple of different ways.

One way is to go to the Home tab, Cells category, and click on the Insert drop down menu.

Insert Delete Format
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/ Cells

Another way is to right click on either a row heading or a column heading and choose Insert.
TO DO: Insert a row between the last budget item and the word Total.

1. Click on the row heading for row 9.

2. Go tothe Home tab, Cells category, Insert drop down menu, Insert Sheet Rows

Or right click on the row heading for row 9 and choose Insert.
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Introducing Formulas

Formulas are used to perform calculations on the data in your Worksheet. You can perform addition,
subtraction, multiplication, and division using formulas. Formulas must be preceded by an equal sign
(=). You can enter a formula by typing it or by selecting cell references. The formula appears in the
formula bar, but the results of the formula are displayed in the cell.

For instance, suppose we had a Worksheet where we wanted to add up the values in cells A1 and B1,
then subtract the value in C1 and put the results in D1. We would go to D1 and type in the formula bar:
=A1+B1-C1

TO DO. Enter a formula to calculate how much is left in the budget fund.

Go to cell D3.

Type =B3-C3 (notice the formula on the Formula Bar) and press Enter.
Notice that D3 now contains the calculation.

Click on D3 and look at the formula bar.

Go to cell D4.

Type =D3-C3 and press Enter
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Click in cell D4.
Pull down on the + handle in the bottom corner and highlight cells D5, D6 and D7 to copy the

N

formula to those cells.
3. Click on cell D5 and look at the Formula bar. Notice that the formula has been altered to pertain
to Row 5. Check out the formula in D6 and D7 too.

Introducing Functions
Excel has many built-in functions that you can use to perform calculations. Functions are found on the
Formulas tab.
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These include basic functions such as AutoSum and functions for Financial, Math & Trig, Statistics, and

more.
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TO DO Include a function to sum the budget.

1. Gotocell B10 and then to the Formulas tab, and click AutoSum.
(Oa = R s Bookl - Microsoft Exce

Home Insert Page Layout Formulas Data Review View Add-Ins
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Insert - Name
Function @ Financial ~ fﬁ? Date & Time ~ ﬁj More Functions ~ Manager & Create from Selection

Function Library Defined Names
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Calculation
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Introducing Functions

Exploring Absolute Cell Referencing

Naming Cell Ranges and Using Name Management

Pasting Data and Using the Clipboard

Formatting and Stylizing in Excel

Formatting Cells

Using the Format Painter

Number Formatting

Using Cell Styles

Creating Cell Styles

Changing Styles

Using and Creating Table Styles

Formatting Worksheets with Themes

Inserting Graphical Elements

Managing Multiple Worksheets
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Saving a Document

Outputting a Document
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